
 آموزشگاه تحلیل داده

 

 در ویندوز Xamarinنصب 

 Visual Studio 2019به  Xamarinاضافه کردن 

 Xamarinنصب 

 Xamarinدستور العمل نصب گام به گام 

۱. Visual Studio 2019 Community، Visual Studio Professional  یاVisual Studio Enterprise  را از صفحه

Visual Studio .دانلود کنید 

 کلیک کنید تا نصب آغاز شود.. روی پکیج دانلود دو بار ۲

 را انتخاب کنید. Mobile development with .NET. بر روی صفحه نصب ۳

 

 در گوشه سمت راست کلیک کنید: Installبودید، بر روی دکمه  Visual Studio. زمانی که آماده شروع نصب ۴

 

 با استفاده از نمودارهای موجود میتوانید نصب را دنبال کنید:

https://visualstudio.microsoft.com/vs/
https://visualstudio.microsoft.com/vs/
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 بزنید:  Visual Studioرا برای شروع  Launchبه پایان رسید، دکمه  Visual Studio 2019انی که دانلود . زم۵

 

  Visual Studio2019به  Xamarinاضافه کردن 

میتوانید  Visual Studio 2019 Installerنصب شده است، با دوباره شروع کردن  Visual Studio 2019اگر 

Xamarin .برای اطلاعات بیشتر را اضافه کنید(Modify Visual Studio  و سپس قدم های بالا را برای نصب ).را ببینید

Xamarin .تکرار کنید 

 را مطالعه کنید. tudio 2019Visual S ،Install Visual Studio 2019برای اطلاعات بیشتر درباره دانلود و نصب  

اطمینان پیدا کنید. اگر  Xamarinمیتوانید از نصب  Helpبا کلیک کردن روی منو  Visual Studio 2019در 

Xamarin   نصب شده باشد، میتوانید منوXamarin :را به شکل زیر مشاهده کنید 

https://docs.microsoft.com/en-us/visualstudio/install/modify-visual-studio?view=vs-2019
https://docs.microsoft.com/en-us/visualstudio/install/install-visual-studio?view=vs-2019
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را در لیست برنامه ها  Xamarinرفته و   Help> About Microsoft Visual Studioهمچنین میتوانید به آدرس 

 بیابید:

 

 قدم بعدی

شما میتوانید کد اپلیکیشن های خود را بنویسید اما برای ساخت و  Visual Studio2019در  Xamarinنصب با  

 را تنظیم کنید.   deviceو  simulator ،emulatorگسترش اپلیکیشن خود ابتدا باید 
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Ios 

 ( Installing Xamarin.iOS on Windowدر ویندوز) xamarin.iosنصب 

 بررسی کلی

موارد زیر را نیاز   Windowsبر روی  Visual Studioبا استفاده از   xamarin.iosبرای ساخت اپلیکیشن های 

 داریم:

  یک سیستم ویندوز کهvisual studio2019    بر روی آن نصب باشد که می تواند یک سیستمvirtual  یا

physical  .نیازمندی های سیستم ویندوزباشد 

   یک سیستمMac   با دسترسی بهApple’s build tool  وXamarin.ios  اینترنت ، که قابلیت دسترسی به

 Apple’sبا کمک وب به این سیستم دسترسی پیدا میکند تا از  Visual Studio 2019را نیز داشته باشد. 

build tool  که برای کامپایل کردن ،native Ios application  .یها نیازمندیضروری اند، استفاده کند 

 ios یستمس

 راهنما!

 Macاستفاده کنید که هردو سیستم ابری   MacStadiumو MacinCloudدسترسی ندارید میتوانید از  Macاگر به 

 ، فراهم میکنند. Xamarin.iosرا برای ساختن پروژه های 

 

 تنظیمات

 گام های زیر را دنبال کنید: visual studio 2019در  xamarin.iosبرای تنظیم 

۱.visual studio 2019 .را بر ویندوز نصب کنید 

 Xamarin.ios  باvisual studio 2019 community ،professional  وEnterprise بر یک سیستم ،

 استاندارد یا مجازی، کار میکند. 

۲.Xcode  وVisual Studio  را برMac .نصب کنید 

https://docs.microsoft.com/en-us/xamarin/ios/get-started/installation/windows/?pivots=windows
https://docs.microsoft.com/en-us/xamarin/cross-platform/get-started/requirements#windows-requirements
https://docs.microsoft.com/en-us/xamarin/cross-platform/get-started/requirements#macos-requirements
https://docs.microsoft.com/en-us/xamarin/cross-platform/get-started/requirements#macos-requirements
https://www.macincloud.com/pages/visual-studio-mac.html
https://www.macstadium.com/
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  Apple’sباید  visual studio 2017برای پخش،  iosاپلیکیشن های  signو  debugبرای ساخت ، 

development tools(Xcode)    وXamarin.ios    از طریق اینترنت بهMac build host configured  متصل

 mac app storeاز  xcodeدانلود و نصب باشند. 

 

 

 توجه!

و نرم افزار   mac build hostمیتواند  visual studio 2019نیستید،   macبر   visual studioاگر مایل به نصب 

 تنظیم کند. برای اطلاعات بیشتر  به طور خودکار، را  xamarin.iosهای ضروری برای ساخت اپلیکیشن های  

Automatic Mac provisioning .را مطالعه کنید 

۳ .Visual studio2019  را بهmac  کنید. متصل 

استفاده کند، باید دو سیستم از طریق شبکه به هم  macبر  ios build toolsاز  visual studio 2019برای اینکه 

 macراهنما اتصال به متصل شوند.

 خلاصه

 ،  xamarin.iosبرای توسعه  mac build hostاین مقاله به بررسی چگونگی تنظیم سیستم ویندوز و ارتباطتش با 

 پرداخته شد. 

 

 

Android  

 (Installing Xamarin.Android on Windowsبر ویندوز) xamarin.androidنصب 

 بررسی کلی

https://apps.apple.com/us/app/xcode/id497799835?mt=12
https://docs.microsoft.com/en-us/visualstudio/releasenotes/vs2017-relnotes#automatic-macos-provisioning
https://docs.microsoft.com/en-us/xamarin/ios/get-started/installation/windows/connecting-to-mac/#automatic-mac-provisioning
https://docs.microsoft.com/en-us/xamarin/ios/get-started/installation/windows/connecting-to-mac/#automatic-mac-provisioning
https://docs.microsoft.com/en-us/xamarin/ios/get-started/installation/windows/connecting-to-mac/#automatic-mac-provisioning
https://docs.microsoft.com/en-us/xamarin/ios/get-started/installation/windows/connecting-to-mac/
https://docs.microsoft.com/en-us/xamarin/android/get-started/installation/windows
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  licenseرا بدون هیچ هزینه  و یا  visual studioهای  editionتمامی  Xamarinاز آنجایی که در حال حاضر 

 xamarin.android برای دانلود و نصب  visual studio installerجداگانه ای شامل میشود، شما میتوانید از 

tools  نیازی به نصب و (.استفاده کنیدlicense   برایxamarin.android  در این راهنما ).که پیشتر لازم بود، نیست

 واهید آموخت:شما موارد زیر را خ

  چگونه مکان مناسب برایJava development kit ،Android SDK و  Android NDK  را مشخص

 کنید.

  چگونهAndroid SDK Manager  را برای دانلود و نصبAndroid SDK .های دیگر ، راه اندازی کنید 

 چگونه یک دستگاه Android   و یا یک شبیه ساز را برایdebug ید.آماده کن  و تست 

  چگونه اولین پروژهxamarin.android .خود را ایجاد کنید 

خواهید داشت  visual studioنصب شده و آماده به کار در  xamarin.androidشما یک پس از اتمام این راهنما 

  خود، خواهید بود. xamarin.android و آماده برای ساخت اولین اپلیکیشن

 نصب

 در ویندوز، اطلاعات کافی کسب کردیم. visual studioبرای استفاده  xamarinپیش تر درباره نصب 

 

 تنظیمات

Xamarin.android  برای ساخت اپلیکیشن ها ازJava Development kit(JDK)  وAndroid SDK  استفاده

ادرس مناسب را خود قرار داده و  پیش فرضاین ابزار را در مکان  visual studio installerمیکند. در زمان نصب، 

برای محیط توسعه فراهم میکند. شما میتوانید این ادرس را از طریق زیر مشاهده و کنید و در صورت تمایل تغییر 

 Tools> Options> Xamarin> Android SDKدهید: 
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 visualبرای بیشتر کاربران این آدرس دهی نیازی به تغییرات ندارد، اما اگر تمال داشته باشید  میتوانید تنظیمات 

studio  را به مکان دیگری تغییر دهید.) مثلا زمانی کهJava JDK ،Android SDK  ویاNDK  را در آدرس

را انتخاب کرده و آدرس جدید  Changeن هستید، دیگری نگهداری میکنید.( برای تغییر آدرسی که مایل به تغییر آ

 را مشخص کنید.

استفاده  xamarin.androidبرای   JDK8و یا بالا هستید باید از  API level 24برای  در حال توسعه اگر

یا پایین تر، میتوانید   API level 23را هم ساپورت میکند.( برای  24پایین تر از  levelهایی با  JDK8 ،API.)کنید

 استفاده کنید. JDK7از 

 مهم!

Xamarin.android  ،JDK9  .را ساپورت نمیکند 

 

 

 

https://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
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Android SDK Manager 

   شما با ورژن های مختلف اندروید،  appهای مختلفی برای یافتن تشابه  Android API level settingد از یاندرو  

 سری بزنید.( android api levelsفهم ) برای اطلاعات بیشتر به استفاده میکند.

های بیشتری نیاز  Android SDKهایی که هدف قرار میدهید، ممکن است به   Android API Levelبا توجه به 

های  emulator imageداشته باشید که باید دانلود و نصب کنید. همچنین در صورت نیاز باید ابزارهای اختیاری و 

میتوانید از طریق  ازکه  ،ب کنیدنص Android SDK Managerرا نیز  از طریق  Android SDKموجود در 

Tools> Android> Android SDK Manager  :به آن دسترسی پیدا کنید 

 

  Visual studio   ،به صورت پیش فرضGoogle Android SDK Manager  :را نصب میکند 

https://docs.microsoft.com/en-us/xamarin/android/app-fundamentals/android-api-levels?tabs=windows
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 Android SDK Toolبرای نصب تمام ورژن های   Google Android SDK Managerشما میتوانید از 

package  استفاده کنید. اگر مایل به استفاده از ورژن های بالاتر هستید، باید  25.2.3تا قبل از ورژنxamarin 

Android SDK plugin  را برایvisual studio  نصب کنید ) درvisual studio marketplace  موجود

 Android SDK Toolsاز  25.2.3در ورژن  Google’s standalone SDK Managerاست.( زیرا که 

 منسوخ شده است.

 مراجعه کنید. Android SDK Setupبه   Xamarin Android SDK Managerدرباره برای اطلاعات بیشتر 

 

 (Android Emulatorشبیه ساز اندروید )

، مفید باشد. برای مثال زمانی که Xamarin.Androidکیشن های روید میتواند در توسعه و تست اپلیشبیه ساز اند

یک دستگاه فیزیکی مانند تبلت در زمان توسعه در دسترس نباشد و یا توسعه دهنده بخواهد پیش از کد زدن چند 

 تست در کامپیوتر انجام دهد.

 گاه اندروید در کامپیوتر شامل بخش های زیر است:شبیه ساز دست

https://docs.microsoft.com/en-us/xamarin/android/get-started/installation/android-sdk?tabs=windows
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 Google Android Emulator-  این شبیه ساز بر مبنایQEMU  که دستگاه های مجازی برای فضاهای ،

 کاری توسعه دهنده میسازد، میباشد.

 An Emulator Image-   یکemulator image مشخصه از سخت افزار و سیستم  ، یک الگو یا یک

میتواند سخت افزار مورد نیاز  emulator imageعاملی است که باید شبیه سازی شود. برای مثال، یک 

روی آن نصب شده  Google play serviceکار میکند و  Android 7.0را که با  Nexus 5Xبرای 

 .android 6.0اینچی با  10دیگر یک تبلت   emulator imageاست را ، نشان دهد و یک 

 Android Virtual Device(AVD)-  یکAVD  یک دستگا ه اندروید شبیه سازی شده است که در ،

emulator image  ،ساخته شده. در زمان تست و شروع اپلیلیشن های اندرویدxamarin.android  ،

 runصب کرده و سپس اپ را را ن APKخاص را راه اندازی کرده،  AVDشبیه ساز اندروید را فعال میکند، 

 میکند.

هایی که برای معماری  emulator imageهستید، با استفاده از  x86اگر در حال توسعه با کامپیوتر هایی با مبنای 

x86 :ساخته شده اند، میتوانید شاهد بهبود قابل توجهی در اجرا باشید و از یکی از دو تکنولوژی زیر استفاده کنید 

１. Microsoft’s Hyper-V – با اپدیت  10از ویندوز  که برای کامپیوتر هایی کهApril2018   و بالاتر استفاده

 میکنند، موجود است.

２. Intel’s Hardware Accelerated OS X Manager(HAXM) –  که برای کامپیوترهایx86  با

 و یا ورژن های قدیمی تر  ویندوز ، موجود است. OSX ،macOSسیستم عامل 

 

 Hardware Accelerationبه راهنما  HAXMو  Android Emulator ،v-Hyperعات بیشتر درباره برای اطلا

for Emulator Performance .مراجعه کنید 

 

 

 توجه !

https://www.qemu.org/
https://docs.microsoft.com/en-us/xamarin/android/get-started/installation/android-emulator/hardware-acceleration?pivots=windows
https://docs.microsoft.com/en-us/xamarin/android/get-started/installation/android-emulator/hardware-acceleration?pivots=windows
https://docs.microsoft.com/en-us/xamarin/android/get-started/installation/android-emulator/hardware-acceleration?pivots=windows
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-Hyper   سازگار نیست. در این مورد باید یا Hyper-vبا  HAXM،  10ویندوز  April2018در اپدیت های بالاتر از 

v  و یا از  یدکن متوقفراemulator image  های با سرعت پایین تر که، بهبودهایx86 .را ندارند، استفاده کنید 

 

 اندرویددستگاه 

 Set Up Device forک دستگاه اندروید، که بتوانید برای تست از آن استفاده کنید، در دسترس دارید، یاگر 

Development یوتر خود متصل کنید و پمالعه کنید و سپس دستگاه را به کاای محیط توسعه، مطرا برای تنظیم آن بر

 از آن استفاده کنید. ،خود Xamarin.adnroidبرای اجرا و دیباگ اپلیکیشن های 

 

 ساخت یک اپلیکیشن

را باز کرده و یک پروژه جدید بسازیم. از  visual studioرا نصب کرده ایم میتوانیم   xamarin.androidحالا که 

 پروژه خود را آغاز کنید:  File >New>Projectطریق

 

 

 

 

 

https://docs.microsoft.com/en-us/xamarin/android/get-started/installation/android-emulator/troubleshooting?pivots=windows#disable-hyperv
https://docs.microsoft.com/en-us/xamarin/android/get-started/installation/set-up-device-for-development
https://docs.microsoft.com/en-us/xamarin/android/get-started/installation/set-up-device-for-development
https://docs.microsoft.com/en-us/xamarin/android/get-started/installation/set-up-device-for-development
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 androidقرار دارد انتخاب کنید و در سمت راست  Templatesرا ک زیر   New Project ،Androidدر پیام 

app  را انتخاب کنید. نام دلخواهی برایapp  خود انتخاب کنید وok  را کلیک کنید)در شکل زیر نامapp   به

 گذاشته شده است(: MyAppدلخواه، 

 

 

 برای ساخت اپلیکیشن های اندروید استفاده کنید!  Xamarin.Androidو حالا شما حاضرید که از 

 

 خلاصه
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و  visual studio ،java JDKنصب کرده، چگونه  یندوزرا در و  xamarin.androidچگونه  یدمقاله، شما آموخت یندر ا

Android SDK برای نصب  ید،کن یمدلخواه تنظ یها یشنبا لوکSDK  ها ازSDK Manager  استفاده کنید، یک دستگاه

 اندروید یا شبیه ساز را راه اندازی کنید و اولین اپلیکیشن خود را بسازید.

 


